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Introduction

This manual was put together to serve as a course manual as well as a reference document used
to guide State Engineers and Consultant Engineers through the standard CAD procedures. New
MicroStation tools for Traffic Design are now available to assist with the adherence to the
standards. For State Engineers these tools can be found in the existing workspace. For
consultants these tools can be downloaded with the CTDOT Digital Design Environment found
on the following web page.

http://www.ct.gov/dot/cwp/view.asp?a=3194&q=483668&PM=1

Please read a detailed description of the issues that we are trying to avoid and how this manual
and the new procedures will assist in the effort.

1. Graphics from reference files are being copied into the traffic sheets and then those
levels are shut off in the reference files. ROW lines from the existing survey ground file
are one example. This is done so the weight can be changed. Referenced design features
from other units are copied in as well. This is done primarily when there are items on the
same levels and some need to be displayed and others do not. This practice makes it easy
to miss updates made to the reference files and then the sheet goes out with the old
outdated information.

Solution: No copying, use Reference Level Overrides and screening on references

2. All traffic appurtenances are being placed in the sheet model. The intersection is then
being cut up and portions are moved to fit within the sheet border. This causes multiple
issues because the traffic signal appurtenances are no longer in the correct geospatial
location.

e Makes it impossible for other engineers to reference the intersection layout back
into the main design files from Highway and Structure Bridge.

e Makes it difficult to find existing underground utility conflicts. The existing survey
gets referenced into the sheet and then the underground utility levels get shut off.
When portions of the intersection gets moved to fit within the sheet they copy
and move only the existing ground features from levels that are turned on. The
levels that where shut off never get copied and moved with the other signal
appurtenances so conflicts will never be seen.

Solution: All traffic appurtenances should be placed in a Design Model so it retains its
geospatial location.

3. Contract Plan CAD Standards not being followed (adopted April 3, 2007)
http://www.ct.gov/dot/lib/dot/documents/deng/CAD Standards.pdf

Solution: Created Tasks for placing standard annotation

4. Traffic appurtenances are copied numerous times for blow ups and details. The design
gets edited and not all copies are getting updated.
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Solution: All traffic appurtenances are placed in the Design model. The deign model
referenced in to the sheet model at 40 scale for entire intersection. The design model is
referenced again at needed scale for detail blow ups.

. The MicroStation pull down menu was confusing because it used abbreviated items, for
example CIJBP (Cast Iron Junction Box).

Solution: Created Tasks that lists the full name for what is being placed.

Questions or inquiries regarding the subject matter can be forwarded to the following
contacts:

Elaine Richard Gabriele Hallock Samantha Scharpf
Elaine.Richard@ct.gov Gabriele.Hallock@ct.gov Samantha.Scharpf@ct.gov
860.594.3278 860-594-3244 860-594-2902
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Section 1 Getting Started

1.1

1.

Opening MicroStation through Accounting

Double click on the Accounting icon located on your desktop.

Within the Accounting Menu select Run Program, choose MicroStation V8i HQ (1).

Select a project number from Available Accounts (2) and then highlight it within the
Frequently Used Accounts. If you do not have a project number you can pick Overhead.

Select the correct Resource Type (3). If you picked Overhead you do not have to pick a

resource type.

Click on the Start (4) button.

& V8.1 CT DOT Accounting Men C=TE0 X

User: HallockGa Computer: |DOT-V‘.H3AECU13

File Help

Run Program: MicroStation V8i HQ ;I Start

Elapsed Time: Inactive VEO} Close

Selected Account: | DOT57197-0156-0171PE-PEO2O

Frequently Used Accounts Awvailable Accounts

DOT57197-0156-017T1PE-PE020 DOTAT197-0156-0170CN-NOTR.
DOT57197-0156-0171PE-PEO20O
DOTA7T197-0156-( FCN-INO1O
DOT 19748 F6-0176CN-INO10
7197-0156-0178PE-PEO1D
]OTSﬁBT 0156-0180PE-PED1D
JOTET197-0157-0081CN-INO1O
DOT&T197-0157-0083CN-IN020

DOT47197-0157-0084CN-NO1O
DOT47197-0158-0193PE-PEO1O

DOT47197-0158-0201CMN-N010

Clear Frequently Used Accounts Configure Location |

Resource Type: PE153 :,

Limit to Project #: r@ |Iter Show All Projects

Instructions:

Please select a Resource Type.
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1.2 Creating a User Configuration File

1. The first time into MicroStation the “out of the box” MicroStation Manager Interface will
appear. Select the Interface pull down first, pick new and type in your Windows Login
user name.

It must match your computer login exactly.

Click the OK button.

s s\BampletC 5
rookin: -, dgn e rE Dy 2D-VE DGN
(T_ w B5400-Cover.Drawing.dgn
s /39 BSI400-Details.dgn

Recent Places m’ESHOCI-HorizontaIAIignment.Drawing.dgn
@’bsiﬂiﬂﬂ-plan.proﬁle.dgn
m /% BSI400-Sheets.dgn
/2% BSH00-W01-Design.dgn
| /2% BSI00-W01-Survey.dgn

E wﬂmﬂﬂ-wﬂl-Terrain.dgn

Desktop

Libraries

o
L]
S MicroStation
Mangaer Interface
@ File name:

Metwork

User: [CTDOTdefaut - |

Files of type: Project: | CTDOTdefaut -

Windows Log+n -. /|
Description: -m
| |

abdissah
abdissaht =
shmadh
akosae
almodovara

-‘--——-

E

MNew.. M
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2. Select the User pull down second, pick new and type in your Windows Login user name.
This will create your user configuration file (.ucf). Click the OK button.

m Create User Configuration File

Name: | Windows Log-n

Files: | sbdissaht uct

ahmadh ucf (=]
almodovara ucf
amemels .ucf

andrewsml ucf w7

[m

Enter name of user corfiguration file.

User: CTDO Tdefauit

Project:

Interface:

4

ucart

ucarf

wailmr
vanderwendep
wanottij
veronesid

Ve

rasca

3. Inthe Project drop down select one of your design projects.

*---------

4 [ |

4. Browse to any .dgn file, open the file and then immediately Exit out of MicroStation.
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1.3 Picking a Project and the CTDOT Workspace

1. Once you get into MicroStation through Accounting you will see the dialog box for
opening or creating new files.

2. Next you will choose a project folder to work in based on what type of file you will be

working on.

1.3.1 Traffic Projects with a Project Number

1. If you are working on a Traffic project with a project number, select the project number
from the Project pull down.

2. Picking the project number will direct you into the project folder.

3. Open the Traffic folder.

Lok in: | 3 Signals # Q@ HE® 20 -VBDGN
y Narme \ Siee | Type
L9 B TR_MsH_TCS_1234_1234_001.dgn "‘ B60KB DGN File
My Recent | [ TR_MSH_TC5_1234_1234_TRAINING.dgn \ 94KB DG File
Documents
— ‘\
F __} .
o —— -
Deskiop “~
My Documents
8 |
My Computer
File name: TR_MSH_TCS_1234_1234_001.dgn b4
‘lf\ Files of type: MicroStation DGM Fies [*.dgn) bt
5
My Network [] Open as read-only

4. If the project you are working on does not have a project folder on the X-drive yet, then
contact Ron Tellier and/or John Rinaldi to request a new project folder. Send an email to
Ron and John requesting the project folder; please include project number and a short

project description (5 — 7 words).

5. From here continue to Section 2, if you are creating a design file or Section 3, if you are

making a sheet model.
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1.3.2 Revisions to Traffic Signal Plans

1.

project number from the Project drop down.

If you are working on a traffic signal plan that is stored in the archive you will select the

2. Then pick the Look in: drop down at the top of the dialog box and select the X Drive.

L
=
Recent Places

Desktop
W=
Libraries
A
Computer
@

MNetwork

Look in:

File Open - X2\

@ DGS CTDOT_Projects (SH3IDGS18) )

k] ©# @

15 Recent ftems
B Desktop
E‘F Metwork
1M sh3dgs18
. CTDOT projects
J 599 _Student 01
| Survey
7 Libraries
A Hallock, Gabriele
1M Computer
&, 0sDisk ()
= Data (D:)
g¢ DGS CSurveys (DOT-SDCENGOTV) (F)
,ﬂ DVD RW Drive {52
¢ GIS Data (L)
¢ Intersection Magic {M:)
Lg# DGS HWYS (DOT-SDCENGD1V) (F:)
Lg¢ GROUPS (\WSDCDBESE) (S:)
¢ TRU Maps (T:)
g HallockGAS (\WSDCDBSED) (U:)
@ VB Workspaces - SHIDGS18 (W)
0G5 CTOOT Prjects (SHIDGS 18) X)
, Favorites
J New folder

11/3/20
3/26/20
7/29/2013 3:02 PM
3/29/2012 8:23 AM
4/1/2008 917 AM

4/4/2013 8:16 AM

9/30/2014 7:57 AM
3/29/2012 7:29 AM
1/23/2015 9:21 AM

-

=5

-~

Type

File fol
File fol
File fol
File fol
File fol
File fal
File fal
File fal
File fal
File fal
File fol _

3

Uzer: [HallockGa

)

7]

[ Cancel | Project: |999_Student01

—

Options - ]

Inteface: [halloc:kga

z]

3. Now scroll down and select TRAFFIC_SIGNAL_PLANS > Traffic > WORKING_FILES and
select the folder for the town where your signal is located.

File Open - X\

Lool in:

-

Q2 i* @

% DGS CTDOT_Projects (SHIDGS18) ()~ i B

I= Marme . Date modified Type =
el | TR_BUS_C2_URS2_2007 3/7/20137:51 AM  File fol
RecentPlaces | 1p pus c2 URS2 2007 3/7/20137:51 AM  File fol
o | TR_BUS_C3_BAKER_2007 3/7/20137:53 AM  File fol
| TR_BUS C3 LOCH 2007 9/18/2014 3:08 AM  File fol
Desktop | TR_BUS_C3_SEA_2007 3/7/20137:54 AM  File fol
— | TR_BUS_C3_URS_2007 3/7/20137:52AM  File fol
=l | TR_BUS_C4_LOCH_2007 3/7/20137:54 AM  File fol
Libraries | TRAFFIC_NONPROJECTS 8/10/201512:56 PM  File fol
| TRAFFIC_SIGNAL_PLANS i 151146 AM  File fol
.,!! | VE_Admin 201511:23 AM  File fol

Computer  Viz_Resources 13 3:29 PM File fol _

4. Now select your dgn file and click Open.
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1.3.3 Non-Project and Non-Signal CAD Design

1. If you are working on a CAD file that does not

have a project number and is not a signal

plan, then select TRAFFIC_NONPROJECTS from the Project drop down.

2. Select the folder with the name of the town where your job is located.

Create your dgn files here.

File Open - XA TRAFFIC_MNONPROJECTS,
Look in: . TRAFFIC_NONPROJECTS < 1 I ~ O Y 2 E- TJ rﬁ
M Mame . Date modified Type =
";ﬁ' . 000-Felder and File Marning Conventions 127472014 10:37 AM  File fol
Recent Places )| gg1-ANDOVER 10/8/2014 11:30 AM  File fol
! J 002- ANSOMNLA 10/8/2014 11:27 AM  File fol
| 003-ASHFORD 10/8/2014 11:32 AM  File fal
Desktop | 004-AVON 10,/8/2014 11:32 AM  File fal
— | 005-BARKHAMSTED 0/8/2014 11:32 AM  File fol
=nll | 006-BEACON FALLS 0/8/2014 11:32 AM  File fal
Libraries , 007 -BERLIM /2472015 1:43 PM File fol
| D08-BETHANY 10/8/2014 11:33 AM  File fol
i_'h . 009-BETHEL 10/14,/2014 9:53 AM  File fol
Computer , 010-BETHLEHEM 10/8/2014 11:33 AM  Filefol
.y 4 m 3
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1.4 Seed Files

3 ]
jul)
A seed file is MircoStation's term for a template. When you select File/New or click the New
icon, MicroStation makes a copy of the selected seed file, places it in your selected project folder and
you give it a new name.

The MicroStation seed files can be found in W:\Workspace\Standards\seed

e For Design Models used to layout design features use the seed file
CT_Design_2D_V8i.dgn

e For Sheet Files that use a border cell and will contain the annotation use the seed file
CT_Sheet_Civil_2D_V8i.dgn

New - W:\Workspace\Standards\seed\

Savein; ‘@seed V‘ @ " g " F.._"j
0 @F\utoCF\DD S'nf_Design_SD_VBi.dgn
Lé 20 )5t _shape_CT_NADZ7FT.dgn
MyRecert  |LPSET M)sv_shape_CT_HADZ7M.dan
Daocuments |23 5tandard_Drawings SH_Shape_CT_NADBSFT.dgn
= CT_CGR_CF'S_Proj_NumI:u_TitleSheet.dgn S'u'_Shape_CT_N.ﬁ.DSSM.dgn
@ MCT_Design_2D_vai.dan

MCT_Design_30_vai.dan
M CT_Design_3D_y8i_Metric.dgn

. CT_Sheet_P.ru:h_2D_'u'8il[3 Lines for Drawing Title). dan
/) M) CT_Sheet_arch_2D_vai.dan

- McT_cheet_Civil_2D_vai.dgn

M CT_shest_Civil_3D_vai.dgn

MJC Arch,dgn

9’ SY_Data_sequisition, dgn

M5 _Design_20_v8i_.dgn

Desktop

My Documents

ty Computer
Q File narne; ‘ b | [ Save ]
My Netwark | Save as bype: ‘ MicroStation DGM Files [*.dgn) v | [ Cancel ]

Seed: |W: \WworkzpacehStandardshseed\CT_Sheet_Civil_2D_48idgn | [ Erawsze ]
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Section 2 Design Models
2.1 Creation

1. Once you have gone through Accounting and chosen your project folder go into the folder
where you want your design file to be located. Click on New File icon.

m File Open - \ish3dgslB\CTDOT_projectsi999_Studentd1\Traffic,

Leek in: ||} Traffic - @ ¥ r -

[ J _all_other_data
el bt | _Eng_Data
Recent Places | Consultants

2. On the bottom right, next to the file path for the seed file, click on Browse.

Lo al o a? o o W W W W W W W W W W W W
WY VAVANVAVAVAVAVAVAVAVAVAVANVAVAVANVEY
Metwork

= File name: -

Save as type: IMicmStatinn DG Files (*.dgn) "'I l Cancel I

Seed: Yhehddas 18NCTDOT_VE_Werkspaces'Workspace < Browse >

&4 MNew - \\sh3dgs18\CTDOT _project=\999_Student01\ Traffic\ 3] ||
Savein: | LGS - @ ¥ @ 3 (&
A== . _all_other_data I
"""_J-'b" . _Eng_Data

X i

3. Browse to W:\Workspace\Standards\seed\CT_Design_2D_V8i.dgn seed file and click
Open.

4. Type in File name: For files used to develop a design for construction projects use the
following file name TR_MST_SSP_#### ####.dgn and Click Save. For non-project study
related you can use any file name.

TR = Traffic (Discipline Designator)
MST = MicroStation Design/Layout (MOdel Type)
Specific Use Three Digit Code

SSP = Signal, Signing and Pavement Marking
DTR = Detour
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| I New - \\sh3dgs18\CTDOT _projects\999_Student01'\ Traffic\ ==
Savein: || Traffic - @ 7 & =
= , _all_other_data
e . _Eng_Data
Recent Places | Consultants
J Sign_Details
! | Signals
Desktop V Slgnl.ng_PvrthTMarklngs_F'Ians
| Special_Provisions
= | Typical_Sheets
@
Metwork
File name: E TR_MST_S5P_1234 1234 dgn| - Save
Save as type: [Mic:mStatiun DGM Files (*.dgn) *] [ Cancel ]

Seed: respacetStandardsiseed CT_Design_20_VEi dan

5. Select the file you just created and click Open.

File Open - Y\sh3dgslB\CTDOT _projects\999_StudentD1 Traffich,

Lookin: |, Traffic - @ T E- Tj 3
[== J _all_other_data
-;,"? | _Eng_Data
Recent Places . Consultants
| Sign_Details
! | Signals

J Signing_Pvmt_Markings_Plans

| Special_Provisions

= | Typical_Sheets

=] TR MST SSP 1234 1234, dgn  —

Libraries

f .-
Emg

Computer

Desktop

,
‘*"\ File name: TR_MST_SSP_1234_1234 dgn - (] open |)

Metwork ———

Files of type: [CAD Files {*.dgn;”.dwg;” dd) v] Cancel

6. Inthe newly created file, Click on Workspace > Preferences, select Reference and Toggle
on Use Color Table.
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7. Next Click on the References button to open the References dialog box.

YWsh3dgs1B\CTDOT_projects\999_Studentd1\Traffic\ TR_MST_S5P_1234 1234 .dgn [2D - V& DGN] - MicroStation VBi (SELECTs
File Edit Element Settings Tools Lhilities Workspace Applications Window Help Location Survey Traffic s Sign

@b B0 B0 =0 -G a0 @{n)e
Tasks v I ¥ —

B Viewl, 2D Design

8. Inthe References dialog box select Attach Reference icon.

) References (0 of 0 unique, 0 displ
Settings

- :f‘ ‘ M}

St ¥

9. Navigate to the Survey folder and reference the Survey *.dgn file, use Survey as Logical
Name and No Nesting for Nested Attachments.

T I O T T LT g i

/% SV_MST_D4_1234 1234_GRN.dgn

10. Select Attach from the References dialog box again. Navigate to the Highways folder,
then the MSta Design folder and reference the highway design file, use Highway as
Logical Name and No Nesting for Nested Attachments.

r ﬁﬂ o
11. Select Level Display and turn off desired levels in the reference files.
Select File > Save Settings.
12. You can also use the tool in the Traffic task menu Select Traffic > Getting Started > Set

Design Model Reference Levels.

I

Getting Started

Q_J) Q| Guide Book

== W Set Design Model Reference Levels
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2.2 Drawing Tasks

In this section you will draw a lane line for a shoulder, place some signs, place some metal
conduits, and draw a traffic signal assembly. These are just a few examples of the many Traffic
Tools.

2.2.1 Tasks Menu

What is a task?

A task is a set of tools grouped to facilitate a particular job/task. Tasks comprise a command with
the correct symbology for a feature and/or pay item.

If you don’t see the Main Task menu click on “Tools” and toggle on “Tasks”, usually it pops back
to the left side of your MicroStation view.

You can dock it where you want it, by dragging the menu to either left or right, up or down to the
arrows appearing when close to the edge.

DI\”_'Y&"IC_C!&”_M“TH’{I(\TR_MST_SS’_I23‘_1234_0”&69" D:\m 1'""'.( c“‘“ 20)7\1'""'-:\"1 MST ssp-lzs‘ 123‘ '’
e ER Bemert Sefings Toois Lbibes Workspace Apphcations Fie Edt Elemert Settings Tools Lhitws Workspace
@ v IF “NAL EQI M > ;v‘_ == o = —
= R_SIGNAL_EQUIPN »| [ 0 v 3 @ - [Rsoncurn~) 23 « o0
B Viewl, 2D Design < Tasks v I X 8 Viewl 2D Desi
» Mq‘l
2 v @)~ (@ @ 1@l Lo BR ’
T @)+ AR RIE £yl o0nTratficyTR msT.s5p 1234 1234 Class| © - @ @)% -
. N\ ,' */
Blattings | Tools Liiies Workspace Appic] |2 Tasks -
> QUIPM v Btributes =Y X
. — . A ——l ¢ Errr.y'y \ 234 }’h'h»'l{o:l-
NO TASKS Standard 1l X ek,
MENUBAR M
man € Roundabouts W v
Tasks
= Civil Geometry
Animation »
Base Geometry ’ A Data Acquisibon
Cells » Print Preparation
Wl Acrdem % CTDOT SheetCompos... sud
Change Tracking »
Civil Geometry » CT Publishing v
Clash Detection » PRSP a
Coordinate Systems »
Curves » Structure Bridge J
Location Survey il
Traffic e
N Drawing v

Page 16 of 62



MicroStation V8i Guide for Traffic Design

2.2.2 Drawing a Shoulder Line

1. Here is one way to draw a shoulder line. Make sure the Pavement Marking Lines tab is
open on the task bar and then click on Lane Line White.

Detectors
Innerconnect
Miscellaneous Features
Pavement Marking Symbaols
Pavement Marking Lines a2
[ Stop Bar
W Crosswalk
Double Centerline
i Centerline Passing Zone (one Dir)

Centerline Passing Zaone (Bath Dir)

" Double Centerline 2 4 Skips

Lane Line \white

} Lane Line Yellow
Lane Line Dbl Wide
Lane Line 10 Dash 30 Skip
7 Lane Line 30 Skip 10 Dash

{ Climbing Lane

ol
74
v
v
v
Vel
s
v
v
Al
v
4
vl

Diotted Lane Line 3 3 Skips

2. This sets the correct level, color, line style, and weight for a lane line. This tool also
activates the place smart line tool. In this example you won’t be drawing the line, you will
copy the edge of road.
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3. Atthe top of the task menu select the Manipulate tools and then Move Parallel.

Tasks -« 0%
@ T T
(Tasks - |
| Traffic |'
e N | 1. _—
oy LR 8 L7 X
1 , E..Jra.“} II; -—ll .-l;zl_l ]
) (] = 3 opy
il\" WO -/ =
- g 2 Move
Getting 5t
—1
4 3 Scale
Ground Eqg| "7
B /;:‘“: 4 Rotate
Span and i 4 =
A 3 Mirror '+ Copy Parallel E' = @
Detectors JJ
~ 6 Arra =1
Innerconn{ © © y (:? || l |J
Miscellane % I Align Elements By E ﬂﬂde [Miter |
Pavement El & Stretch o EStEII‘ICEZ 4.000 x{:c
?3 . | Use Active Attributes

Mowve Parallel )

Pavem ent||

| Make Copy

4. Set up the Copy Parallel dialog box as shown above. The top button should be set to
Element because you will be copying an entire element. The Mode is set to Miter. This
mode will lengthen or shorten the element to try to match the shape of the original. The
distance is set to 4 feet. Check Use Active Attributes to create the copy using the active
attributes. Most importantly check Make Copy or else you won't get a copy.

5. Now click on one of the pink edge of road lines and move the cursor to the inside of the
road and click. Now you should have a shoulder line 4 feet away and parallel to the edge
of road.

\, Copy Parallel ‘:ll:-ﬁ

@ o5

Mode: (Miter v |
v | Distance: | 4.000 ﬁ
¥ | Use Active Attributes

+ | Make Copy
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2.2.3 Placing a Sign

1. Make sure the Sheet Aluminum Signs tab is open on the task bar. Then click on 1 Post.
Then click to place the sign cell. Next you will want to rotate the cell so the sign face is

aligned with the roadway.

2. Inthe Place Active Cell Dialog select Interactive and Rotate Only

3. Data Point where you would like to place the sign and spin it by moving the curser to the

desired rotation. If you do not like where you originally intended the sign to be placed

simply right click to release and then Data Point in the correct location. Spin the curser

again and Data Point a second time to place.

Favement Marking Lines

Traffic Signal Signr
Sheet Aluminu .

v

e

1 Post f/

S T T i O o o S o E O
{

W 2 Side by Side 1 Post

} Parapet Mounted Right

3 Overhead Mounted

Extruded Aluminum Signs ]

3 Side by Side 1 Post

1 Post Back to Back Moun

2 Posts Back to Back Moulj /" gL
- | 1.000000 _ﬁ
: [1.000000 15 Al

2 Posts

3 FPosts

| True Scale
Belative

Parapet Mounted Left

Wigor = aak o] M
‘ V| Interactive | Rotate Only A ,
: Hatten Taop -

rlae

Scale Multidine Offsets
Scale Dimension Values
Scale Annotations

ASSOCIEtian
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2.2.4 Placing a Metal Conduit

1. First select the Ground Equipment tab from the Task Menu.

Tasks

== fos il |

+ IX

[~ ]

Tasks
J |Traﬁ:in:

T

Getting Started

',\Et‘ 3 Pedestnan Push Button
-,\h- ' Pedestnan Push Button Left
-,\lk- E Pedestnian Push Button Right

F tal hounti

o

X LB AL 5
E[EPL."_]! I\")r @p A‘, _\I}FF_:L

Ground Equipment M

.v. b

2. Then select the Rigid Metal Conduit tool.

N ANAI A A AN NN

-,\Ft- Existing Handhaole
"'\E’ Sawcut

“J Rigid Metal Conduit H—

¥ Existing Rigid Metal Conduit

Span and Maunt Assembly

w
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3. You can place the conduit as straight sections as shown below.

4. Then select Construct Circular Fillet.

Tasks

v X

Tasks
J | Traffic

B Viewl, 2D Design

2 -l -

o e S O TR I Pl e e PO O

ﬂ;iim_r :‘_'Jr ﬂp Ar T

Getting Started

Ground Equipment T P

Q

Pedestrian Push Buttol
Pedestrian Push Buttol
Pedestrian Push Butto
Pedestal Mounting
Auxillary Equipment C
Auxillary Termination
Cast Iron Junction Bo:
Controller

Controller with Pad

1 Modify Element
En(' 2 Break Element
/3 Extend Line
4 Trim To Intersection
,!‘“— 5 Trim To Element
TF 6 Trim Multiple
}'5 71 Insert Vertex
1% 8 Delete Vertex
" 9 Construct Circular Fillet
& 0  Construct Parabolic Fillet
S 0 Construct Chamfer
= Qpen 'Modify' as Toolbox
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5. Type in a radius of 10 and truncate both.

_, Construct Circular Fillet EI [=] @

Badius: | 10.000

6. Click one line then the other and an arch will be constructed between the lines.

\\

7. Once you have placed all the segments of the conduit, select the Create Complex Chain

tool to connect all of the segments. Click on each segment and this will redraw the line as
one continuous element.

Task
858 vIX 2 Viewld Design

J' Tasks - -|
| Traffic |'

X i 2
i[\.i rﬂ_» !‘_F;Ir ﬁr

Getting Started

A

|H,<
=]
(=]

—
:I: =2

(%]

Create Complex Chain

[[EN)

Create Complex Shape
Ground Equipmen

4=

Create Region
Tl} O Pedestrian Push

) Add Te Graphic Group
W Pedestrian Push

[[=3]

) Drop From Graphic Group
E Pedestrian Push

) 1 Group Hele
R Pedestal Mountin

U @ % H# B [0)M

TR The Thoem TR

Open 'Groups' as Toolbox

T | Awcillary Equipmd
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2.2.5 Placing a Signal Assembly

1. First place some Steel Span Poles. Select a Steel Span Pole cell then place the poles.
Rotate as needed.

Ground Equipment v

Span and HountAssemhlyﬁ

3 Audible Ped Signal
4

W Traffic Signal Face h

E Span Wire / Mast Arm

[

R Span wire Attachment

Strain Insulator

4
| A Steel Span Pole h |
5 ‘wood Span Pole
) Utility Pole

F Bxasting Steel Span Pole
5 Existing Wood Span Pole

Z Existing Utility Pole

* Anchor | Guywire

=
3
\-51
=
> C
%
=
3
%

[

2. Now click on the Span Wire / Mast Arm tool and place the spans or mast arms. Also use
the Span Wire tool and draw lines that will connect from the Spans/mast arms to the
traffic signal face symbols.

3. Select the Traffic Signal Face tools to place the triangle symbols to the line placed in step
3 and clip the lines to the signal face symbols.
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4. Now you are going to use AccuSnap to place the Span Wire Attachment circles at the
intersections of the span lines. If you don’t already have the Snap buttons docked on
your screen go to Settings < Snaps < Button Bar. Then drag the button bar and dock it
where you like it on the screen. Double click on the Intersect Snap to lock it.

-$-|.»'|£|’*\_—L 0

Intersect Snap

Another good choice for snapping is the Key Point Snap. That is usually the snap turned

Snap Mode

E

d

oy

(=)

on by default. That is the second snap from the left. You may want to double click that
snap after placing the circles.

5. Now select the Span Wire Attachment tool from the Task Bar and click on the
intersection of the span lines.
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6. Now select the Trim Multiple tool and set it to Trim.

SR

Q -

v TrX

B Viewl, 2D Design

| By Tasks

Facilities

| Highway

7. Select the Circle for
click on the line seg

ﬁ élﬂl?»i% >ﬂ?>ﬁ3€'>ﬂ+:

9 Roundabouts

2 Civil Geometry L>,( 2 Break Element

¥ F T TEm =
Q| W e | 2 EdendLine
wl R AR N,

'ﬁ = /\ 4 Trim To Intersection
E/7 2 Ay

) (S §
: ;a"r ?ﬂ 1 — /-\— 5 Trim To Element

— 3

T2 ~ ‘:tt 6 TrimMultip|EK
a7 ;f }‘2 7 Insert Vertex \
" S B3l
/M, Data Acquisition j & Delete Vertex

Print Preparation
CTDOT Sheet Composition

CT Publishing

G TrimMultiple [ = | @ | 2=

[

Medify Element

o

Construct Circular Fillet

=

Construct Parabolic Fillet

Operations
Open 'Modify' as Toolbox

=5
Civil _\ 0  Construct Chamfer
e
o

the cutting edge and click on the ends sticking out of the circle and

ments inside of the circle.

Getting Started v
Ground Equipment v
~

Span and Mount...

e
\? O Audible Ped Signal

Wl
\% W Traffic Signal Face
'/: E Span Wire | Mast Arm

e
\? R Span Wire Attachment

Joll
\-R Strain Insulator

e
7% A Steel Span Pole

m

e
\? S Wood Span Pole

e
\? D Utility Pole

e
\% F Existing Steel Spe.

e

\? G Existing Wood Span Pale
N

\? 7 Existing Utility Pole

Wl

\% X Ancher | Guywire

e .
\-R C Luminaire on Pole

N
\? v Mounted Pedestrian Signal F

Wl
\% B Mounted Traffic Signal Face

Detectors

Miscellaneous Features

v
Innerconnect v
v
v

Pavement Markina Svmbols
2 Tasks | @ Project Explorer

X[ 99327 668 X 672145 288 tells you what to do
Q@ -© -\ [ momgnvem <) Eedfilz[o]]s[o]ss| [F

Trim Multiple > Identify cutting elements / edges

ELEMENT(S) TO TRIM

» Trim Multiple '

SN

MicroStation
Command Prompt :

«

next....

_J| & TR_SIGNAL_SPAN_AS
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Section 3 Sheet Models
3.1 Creation

1. Create a new dgn file (we will be creating a Traffic Control Signal Plan), but this time use
the seed file W:\Workspace\Standards\seed\CT_Sheet_Civil_2D_V8i.dgn.

Use the chart below as a guide for naming the file. Use either the project number or Intersection
number in the name along with the drawing number as needed.

Traffic Control Signal Plan Sheet

TR_MSH_TCS_1234_1234_###.dgn

Detour Plan Sheet

TR_MSH_DTR_1234_1234_###.dgn

Pavement Marking Plan Sheet

TR_MSH_PVT_1234_1234_###.dgn

Signing and Pavement Marking Plans Sheet

TR_MSH_SPM_1234_1234_###.dgn

Signing Plan Sheet

TR_MSH_SGN_1234_ 1234 ###.dgn

Maintenance and Protection of Traffic

TR_MSH_MPT_1234_1234_###.dgn

2. Reference in your Traffic Design File completed in Section 2. Turn on Save Relative Path
and click Open.

Attach Reference - X:\999_Student_01_Traffic\Traffi

Traffic v > B -5

Lookin: |

2D -V8 DGN
e | _all_other_data :
| . | Eng_Data Traffic Design File W |
Recent Places | Consultants created in Section 2
| Sign_Details
! | Signals
Desktop ) Slgnl_ng_P\.fm_t__Marklngs_Plans
| . Special_Provisians
‘ | Typical_Sheets y @
i~ M TR_MST_SSP_1234_1234.dgn
Libraries M TR_MST_SSP_1234_1234_Class-Final.dgn
‘k Attachment Method
Computer ’Interacﬂve hd

File name: TR_MST_SSP_1234_1234.dgn

3 [oma ) O

Options

Files of type: [CAD Files (*.dgn;*.dwg;”.dxf)

- Fﬁave Relative Path @

3. Give it a Logical Name of Traffic Design and Nested Attachments should be set to No

Nesting.

4. Repeat for the Survey Ground File. Give it a Logical Name of SWW Survey and Nested
Attachments should be set to No Nesting.
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5. If required repeat for the Highway Design file. Give it a Logical Name of Highway and
Nested Attachments should be set to No Nesting.

6. Rotate view as needed. Select the Method 2 Points and data point following the prompts
to Define your X axis.

® Viewl, 2D Design

'} Rotate View

Method:; |2 Points

W T

o Rotate View > Define first point

R,
K <

7. Access the Sheet Composition Task. Now you will see another set of tasks, all related to
working on Traffic Sheets.
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Extruded Aluminum Signs Route Markers

Accident Symbaols

' Sheet Composition

Miscellaneous Symbaols and Details

Tasks - 0 M
Q - " |
J’Tasks - |
| Traffic r
Task
j:""": ?. ;l E asks * 1 X
1 ﬂ‘hﬂ' r—'l'; rJ b i J" 3 '@ - i |
B -
L '_) @ A # r_j Tasks - |
J_l- L] * L] L] ] - "
Traffic —
Getting Started - | Sheet Compasition r
Ground Equipment - ?
B = ca = " jJ rJ jJ'rQ}J”
pan and Mount Assembly / L
o, ‘_:lr ﬂr Ar "hr-r_;lr
Detectors w
Setup and Borders W
Innerconnect v
General Annaotation W
Miscellaneous Features W Signal Plan Annotation -
Pavement Marking Symbols L T T E— "
Pavement Marking Lines L4 Phasing and Mavements w
Traffic Signal Signs b Charts v
Sheet Aluminum Signs b4 Sign Details A
- b
w b
b

Dimensioning

k
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3.2 Attaching a Border and Clipping the References

Major changes have been made to the signal border, there were four to choose from and now it
has been combined into one. All other types of sheets will use the general plan sheet border.

1. Before clipping your Reference files copy in the North Arrow from the Survey Ground file.

2. Goto the Setup and Borders Task Menu and select a border cell and place it. When
working on a Signal Plan as we are, you will also need to attach the Detector Chart,
Program Chart and Phase Chart. These are cells that can be attached using the Sheet
Composition Task. These cells will be placed under the Signal Border Movement Diagram
from left to right in the order below.

PLEASE NOTE:
Do not use the Drop Element command on the cell borders, this will cause multiple issues.

Setup and Borders = A
ﬁ @ Set Sheet Model Reference Levels
-,#— | Plan Border

E | Signal Border 1

R | Movement Diagram Detector Chart 2

T | Movement Diagram Program Chart 3

A | Movement Diagram Phase Chart 4

5 | Sign with Flashers Intersection #

0| Index of Drawings Tahle

F 11x& Border
= G 8x11 Border

£ |Flashing Sign Border

# Collision Diagram Border
5% €| Edit Tags
:‘ﬂ'ii W Fill In Single Enter-Data Field

A% B Edit Text

(" 4. Create Clipping Boundary Shape

| Aqnaotatio
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3. Select the Create Clipping Boundary Shape on the same task menu. Place a shape
around what you want inside your Border

Sign with Flashers Intersection #

\&r D' Index of Drawings Table

33 F|11x8 Border

33 G|Bx11 Border

-\>- Z Flashing Sign Border

-\>- X | Collizion Diagram Border
5% ©|Eqit Tags

AB6 W Fill In Single Enter-Data Field

A% B|EditText

' ("%, Create Clipping Boundary Shape i

4. Now go to the References dialog box and select all of the reference files. Right click on

them and select Clip Boundary.

5. Select the Method Element and data point on the element that was placed in step 3.

L7 References (6 of 6 unigue, & displayed)

Tools  Settings
|

SELECT ALL

% Detach '} Set Reference Clip Boundary E\' =] '@
- Reload Method:; Element |
Exchange || Discard Existing Clip Masks
Scale | 1.0001 . . 0 ] ]
: Cpen in New Session — Uze References Dialog List
EEW Activate j’Eﬂ
Mew Level Dis  Deactivate oreferenced: | b

PLEASE NOTE:

If you are unable to fit the entire design within one border, make additional dgn files;
one file for each sheet. You can also reference all the files in again (Traffic Design
Highway Design and the Survey Ground file) and then move them together to a blank
area on the sheet and clip them as needed. Do not copy in these reference files.
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6. Click on the Models Icon.
(Ao -=-e-B-la-=-%-g

7. Use the Sheet Boundary tools to move your Transient Shape (Plotting Boundary) into

place around the Border Cell. Use the Move and Rotate tools shown below and follow
the MicroStation prompts for accurate placement.

Models

o
Active File = j =

Type 20730 Name it 4 Design File
- ] CT_Civil_2D_Shest CT_Civil_Sheet s

Sze: CTDOT 2032 ~] &)
Scale: [CT40 -] &l
Border: Y

TRANSIENT SHAPE
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8. Use the Edit Tags tools to fill out the Blue Town, Drawing Title, Project Number and
Drawing No.. Use the Data Field and Edit Text tools to complete edit the green text.

J Tasks sl

il fifrine I—T

| Sheet Composition

1 2
7 > |7
J—JF et » J) AP \/ » r—j)
Setup and Borders Bm=E A

2 Set Sheet Model Reference Levels

INTERSECTION #

TOWN NAME 2
TOWN NAME 1

DRAWING TITLE

TRAFFIC CONTROL
SIGMNAL PLAN

/ Fill In Single Enter-Data Field

Ai; B Edit Text
¢ & Create Clipping Boundary Shape

General Annotation

Vol alal
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3.3
3.3.1

Adjusting the Appearance of the Sheet

Update the Display Sequence of Reference Files

1. Inthe references dialog box click on Settings > Update Sequence. The sequence is the
order in which MicroStation loads the files. When a file is listed at the top of the
sequence, that means it is loaded first and will appear on the bottom as if it is below the

other files.

2. Using the Update Sequence... tools (up and down arrows) move the files either up or
down to the desired location(s). The Active Design file should be the last file in the

update sequence, meaning this is the last layer the printer/plotter prints, see update

sequence graphic. When finished click Ok.

1] References (6 of 6 unique, 6 displayed)
Settings
Attachment ...

E kA
-~ | Update Sequence... 4

Slot Adjust Colars... Name

Tools

-

Update Sequence

CX | A | v VD ¢ MOVE FILES UP or DOWN

23

Slot  File Name Model Logical Name
1 _\HW_MST_MDL_1234_1234_layou. 3D Design Highway
2 ANASV_ D1.1234 1234 GRN.dgn 3D Design SWW Survey
3 LATR_MST_SSP_1234_1234 Clas... 2D Design Traffic
5 L AHW_MST_MDL_1234_1234_Layou. 3D Design Highway-1
6  .ATR_MST_SSP_1234_1234 _Clas... 2D Design Traffic-1
7 . NTR_MST_SSP_1234_1234 Clas... 2D Design Traffic-2
TR_MSH_TCS_1234_1234 001dgn CT_Givil_2D_Sheet Active Design File
4 | I [

Defat | [ ok | [ cace | BEFORE
[ Update Sequence 23
A~ Al v v
' Slot  File Name Model Logical Name
Y| 2 A \Survey\SV_D1_1234_1234 GRN.dgn 3D Design SWW Survey
11 1 .NHW_MST_MDL_1234_1234_layout.dgn 3D Design Highway
3 \TR_MST_SSP_1234_1234_Class.dgn 2D Design Traffic
5 . \HW_MST_MDL_1234_1234_Layoutdgn 3D Design Highway-1
6 . ATR_MST_SSP_1234_1234 _Class.dgn 2D Design Traffic-1
7 .\TR_MST_SSP_1234_1234 Class.dgn 2D Design Traffic-2
TR_MSH_TCS_1234 1234 001.dgn CT_Civil_2D_Sheet Active Design...
< M — }
Defat | [ oK | [ Cancel | AFTER
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UPDATE SEQUENCE GRAPHIC

Cut Sheet File
Publish to PDF

2D Design File

Survey File

3.3.2 Level Display

1. You will need to turn off some unneeded levels from the highway or ground file. Click on
Level Display to open the Level Display Dialog box. This way you will see which levels get
turned off.

2. Select the Setup and Borders tab on the Sheet Composition task and select Set Model

Reference Levels.
Setup and Borders ER=E A
(= Q set Sheet Model Reference Levels )

\,k.r ‘W Plan Border
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3.4 Pull Down Menu

There have been many changes made to the drop down menu. The drop down menu formerly
had a section called Traffic and a section called Signing. These sections have been renamed to
Traffic Notes and Sign Details. The items from the drop down menu that represent physical
objects, such as aluminum signs or pavement markings, were relocated to the Task Menu. The
items that are graphics or text used for annotation, such as notes or sign details, were left in the
drop down menu.

DGM] - MicroStation VBi (SELECTseries 3) (1)
p  Location Suwe'_.erﬁic Motes  Sign Detailf):TDDT 2007 Lkilties

L—-—-....—.....r'\_.-.l-v-

3.5 Sheet Composition Task

In this section you will be using some of the new tools that were created for making sheets.
There are two menus for Annotation; General and Signal Plan. The General Annotation has a
larger font size and the Signal Plan Annotation has a smaller font size. The Sheet Composition
Task can be found using this path in the task menu Traffic > Sheet Composition.

Tasks - 0 %

Tasks v | _

Traffic =
J ‘ Sheet Composition |‘
o, I:‘_)r ﬁr Ar > r-r_jr

Setup and Borders

General Annotation
Signal Plan Annotation
Signal Head Diagram
Phasing and Mavements
Charts

Sign Details

Route Markers

Miscellaneous Symbaols and Details

¢i|¢||¢|(¢|¢(|¢||¢|[¢| ¢ ¢

Dimensioning
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General Call Outs

1. Select the General Annotation or Signal Plan Annotation tab on the Task Menu.

Tazk:

1
-
X

JTasks - |

J Traffic —
| Sheet Composition |‘
N 1.0 oea o i
H : - Sy A s A g

B ETREIEY: JeN 74 6 v

o= I::)b @b A> ~> }j’r_ﬂb

Setup and Borders - | -
-~

General Annotation n==

4 Call Out

W General Notes Title
E General Notes

F HexagonText Frame

T Circle Text Frame

& Detailing Note

5 Detailing Text

[ Proposed by others Text
Existing Texut

3 Approx. RO

Z Approx. Street Line

m

# Taking Line

C Street Name

W Match Mark Text
B Match Mark Line
Begin Project Limits
End Project Limits

Limit of Construction

PN S S S S AR CCR

Match to Existing Pavement Makings
4+ Edit Text
e Match Text Attributes

a¥ Change Text Attributes

Signal Plan Annotation -

Signal Head Diagram
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2. Select the Call Out tool. In the Place Note Dialog box make sure the left tool ‘Place Note’
is active and Start At is set to Terminator.

3. Type in the note you wish to place in the text box that appears.

@ Place Note

Text Style
Dimension Style
Text Rotation
Text Frame

\‘F@

/qﬁ Place Mote Q:

Height:

=

=

2

. | Horizontal
. [ None
4.800

Width: | 4.800

Horizontal Attachmert: | Auto

/

—l

Location: | Manual
\ﬁderﬁpe: [ Line
Start At: | Teminator

|

|

Al

V| Apply changes to all text

|
|
|

)

Text Editor - Word Processor

= - ABC 1
|5225verdana |B‘I‘g“"a§

2
| | | | | | | I | |
&

2" RMC, 14/9, 14/5

V| Indine Leader

FASS0CIEton

4. Click on the item you wish to annotate and then click in the location you want the note to
be located. Right click to place the call out.

3.5.2 Circle and Hexagon Text Frames

Typically on a Traffic Signal Plan signs are annotated with a circle text frame. On the Task

Menu make sure you are in the Signal Plan Annotation tab. Then select the Circle Text

1.

Frame tool.

2.

L Y A AL 2 292
Setup and Borders v ~ B
General Annotation v
Signal Plan Annotation xm = mm &

A Q Call Out
A "/ Generzl Notes Title

A E General Notes

@ A HexagonText Frame /
® x

/A A Detailing Note

Circle Text Frame

| ~ 1 |
| General Notes |

Make sure the Place Note dialog box that comes up is set to Place Callout.

P

A S Detailing Text

() Place Note

oA

A®

Text Style: \AJ CT_OBO le‘Place Callcut‘b;
Dimension Style: |1 CT_Traffic_Circle v | Q| 2y

Text Rotation: | Horizontal

Text Frame: [Circle v |
Height: | 3.200
o A
Width: | 3.200 L ——J

7| Apply changes to all text

A 0 Proposed by othersText

/ \A 7 Rig7 N\ NN
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In the Text Editor dialog box type in the letter for the callout. Then click on the screen to

place the callout bubble.
E=E(E=E =
| S

4. Construction notes use a hexagon text frame. You should follow the same procedure

shown above, but choose the Hexagon Text Frame tool instead.

Page 38 of 62



MicroStation V8i Guide for Traffic Design

3.5.3 Labeling and Notes

Select General Annotation and browse through the labeling and notes options.

1. The General Note Title uses larger text than the General Notes.

General Annotation

PAVEMENT MARKING NOTES

-
i
n
> | ¢

Signal Plan Annotation

A Q Call Out

'/ General Notes TV
E General Notes

HexagonText Frame
SIGNING NOTES:
Circle Text Frame

S Detailing Text
D Proposed by othersText

F Existing Text

@
@
A A Detailing Note
A
A
A

2. The Approx. R.0O.W. text will appear in the dialog box automatically and you choose the
method of placement for example: Below or Above Element.

Setup and Borders ¥ |

- TextEchtcr Word Processor =
General Annotation v
Signal Plan Annotation &x = s & B I

A O Call Out
A W General Notes Title
A E General Notes

@ R HexagonText Frame

€ Place Text o=@ ==
@ T Circle Text Frame

Method: |Below Element b
A L Detailing Note Test Style: [A# CT_080 »] Q|

A S Detailing Text Active Angle: | 0.0000°

Height: | 3.200 J
A [ Proposed by othersText Width: (3200 |, s

A F Existing Text V| Apply changes to all text

A
‘ A G Aoproc ROV, e ‘ Fort: | 229 | (B3 228 verdana v |
A 7 Approx. Street Line i dustfication: |Ml
Line Spacing: | 0.675000
A X Taking Line Interchar Spacing: | 0.000000
| Text Node Lock
A _ Street Name

I
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3. Some more examples of annotations.

Setup and Borders

| -
General Annotation H=HE

A0 Call Out

A ‘' General Notes Title

YV V.V,

e ER

A_ 7 Approx. Street Line

A Taking Line

A END OF

C Street Name

AV Match Mark Text STATE PROJECT NO. 98'103
/B Maich Mark Line CT ROUTE 139 ¢ STA. 26+50

m

A Begin Project Limits

|[A o e |

fA Limit of Construction
,/A Match to Existing Pavement Makings
AF EditText

A% Match Text Attributes

A PN

General Annotation == = = ~
Q Call Out
" General Motes Title

General Notes l 3 9

R HexagonText Frame

-

Circle Text Frame

A Detailing Mote

5 Detailing Text

I Proposed by others Text
F Existing Text

5 Approx. R.O.W.

Z Approx. Street Line

X Taking Line

Street Name

W Match Mark Text
E Match Mark Line
Begin Project Limits

End Project Limits

232Nl
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1. Even though the labeling of the traffic signal faces is annotation, it should be placed in the
traffic signal plan. This way you can make a blow up to more clearly show the intersection
and the signal face annotation will scale along with the rest of the design file.

2. Highlight the Traffic Signal Plan file in the References dialog box.

3. Right click on the reference and select Activate.

1) References (6 of 6 unique, 6 displayed)

Tools
Slst ¥ 4 Logical File Mame Model Description
2 SWW Survey O MSurveytSY D1 1234 1234~ A ann-——— o 30 Design Seed
i Traffic VTR MST SSP 1234 1234 ¢ Attach.. Aligned with Maste
4] Highway-1 DU AHW_MST_MDL_1234 10 Detach 3D Design Seed
& Traffic-1 MNTR_MST_SSP_1234 1234 0 Rejoad Aligned with Maste
7 Traffic-2 MWTR_MST_SSP_1234 1234 0 B Aligned with Maste
Exchange
. Open in Mew Session
Activate *——l
Scale | 1.000000 1.000000 - set X | 0.000
B Bl > ITJI_JFJJ —
MNew Level Display: |Config Varable = | Georeferenced: -
Copy
Scale
A AW AV AW AW AV AN

4. Now the elements in the active reference appear in their normal colors, but everything else
appears grey. You can now manipulate the reference file and the elements within it.
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5. Inthe Signal Plan Annotation tab select the General Notes tool. Set the Method to Above
Element. Type the number for the signal and click on the triangle that represents the signal.
The number will appear aligned with the triangle for the signal face. Click to accept, and then
move the number as needed to fit inside of the triangle.

Signal Plan Annotation as = mm &
oA O Call Out
A ' General Notes Title

|A E General Motes h |

@ R HexagonText Frame

@ Circle Text Frame
A A Detsiling Note

» Jid Text Editor - Word Processor EI =] @
A_ S Detailing Text | : | il 1

B |53 229 verdana - Al ~
A D Proposed by othersText B ‘ I ‘ g ‘ v ‘ 2
A F E}('snng Te\xt |‘ . . . . . | . . . | . . . |
A 53 Approe. RO W
A Z Approx. Street Line r
A X Taking Line
A C Strest Name ) Place Text
AV Match Mark Text Method: |A‘b0\re Element
. Text Style: (s CT_D30

» B Match Mark Line Active fngle: | 0.0000°

Height: | 3.200 T.‘
Width: | 3.200 J
A+ Edit Text V| Apply changes to all text

{_) Circle Detail Blow Up

Match Text Attributes

6. When you are done making your changes to the Traffic Design file, right click the reference
file and select Deactivate. Now the changes will be applied to the reference file.
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3.5.5 Linear Dimensioning

1. Go to the Dimensioning Tab on the Task Menu.

= v X > Dimensioning S
v v | #A
= kv i l; Eﬁ O Set Pavement Marking Level
Tasks <
Traffic —1 Ej W/ Set Detectors Level
Sheet Composition & } —
l r} -’-‘j E Set Signal Equipment Level Q
Y O @ LY A ono ] >
1|§ 2} 2p* .ﬂ? .g::-,ﬂfﬁ 8l 9N, gj R Set Signal Sign Level Q
) O @ A, 1 -
QTJ' + g' 4 ¢> r_ﬂ' ) :Zj T Set Sheet Aluminum Level )
SSiup and Borders v b =3 A Set Extruded Aluminum Level 8
General Annotation v
} g3 S SetROW Level
Signal Plan Annotation v
‘=) D Set Detailing Level
Signal Head Diagram v } rgj
} I3 F Dimension Size Perp - Pts c
Phasing and Movements v (=]
Er— = |L G Dimension Element g
e e v } r_1 Z Dimension Linear Q
Route Markers I } [7'_1 X Dimension Along Curve .§
Miscellaneous SYWs v 3 C Modify Dimension o

2. Select the Sheet Aluminum Dimensioning Level tool to set the active level.

Iy

[ u |

Dimensioning - —

4

& Set Pavement Marking Level
W Set Detectors Level
E | Set Signal Equipment Level

Set Signal Sign Level

Set Sheet Aluminum Level 2

Set Extruded Aluminum Level

Set ROW Level

0o v =413

Set Detailing Level

sospphass

Dimension Size Perp - Pts

.\
wl
-

-

o

Dimension Element

Il

Dimension Linear 3

Dimension Along Curve

]

BLINL

Medify Dimension

A

2
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3. Select the Dimension Linear tool.

4. In the Linear Dimensioning dialog box set the Alignment to True and then click the
magnifying glass to open the Dimension Styles dialog box.

r'::j Linear Dimensicning El [=] @-‘
1 CT_Dim_Treffic Q0 s

Blignmert: | Tue
Location: [Manual
Diim Cffset: | 0.000

ERGEEED

5. Inthe Dimension Styles dialog box go to the Units tab. For the Units change the Accuracy

to 0.
Dimension Styles - CT_Dim_Traffic EI (=] @
Stvle  View
T ir me - —
= DA X S
Dimension Styles | || Geometry | Units | Test | Symbology | Advanced
q" 200 Primary Units Secondary Units
z 500 V| Use Working Units Show Secondary Units
bt ;Egg Lzbel Format: (MUlzbel 2 7 Label Format: (MU -
i Master Units: - | -
%2 CT_Addendum_CO e jg—fﬂm_e
& CT_BOP o R T =
% CT_ConstrLimit ccuracy (0 x] -
% CT Dim Lane Main Prefoc: Main Suffoc:
%2 CT_Dim_Rdwy Upper Prefoc Upper Suffoc: Lower Prefoc: Lower Suffic
% CT_Dim_ROW Leading fero Trailing Zeros Leading Zeno Trailing Zeros
CRSFEL e Atempte Label [ S
< CT_Dim_Traffic_20 /| Atemate Label Settings - Altemate Labe Settings -
%3 CT_Dim_Traffic_30 B PR
'@Iﬁ CT_Drai cale gle Fomat
% CT_Drainage_X5C = Reference Scale Units: | Angle r
%2 CT_EOP Scale Factor: | 1.000000 Display: |D.DDDD -
¢ CT_General Accuracy: [0 -
%f CT_NonPay Metric Format Leading Zero Trailing Zeros
‘t_ﬁ CT_PdByOthers lUze Comma for Decimal
F CT_ROW Units Separator: | 1234 56 A
3 CT_ROW_Hex
¢ CT_Traffic_Circles
¢ CT_Traffic_Hex
%2 Full
% PM_angles_Deci_prop
% PM_angles DM5_exist -
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6. Now click on the object you are using for a reference (1 — catch basin), and then click on
the sign (2). Next click to determine how far the dimension will extend (3). Click one
more time to place the number value for the dimension (4). At this point you can right
click to finish using the tool, or if you have another sign farther down the alignment you
can click to that sign and an additional dimension will be drawn.
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3.5.6 Dimensioning Length Along a Curve

1. First click on the tool to select the level of the object you are dimensioning.

2. Then click on Dimension Along Curve.

Dimensioning

Eﬁg

o Set Detectors Level

Set Pavement Marking Level

Set Signal Equipment Level
Set Signal Sign Level

Set Sheet Aluminum Level

L Set Extruded Aluminum Level

Set ROW Level
Set Detailing Level
Dimension Size Perp - Pts

Dimension Element

£ Dimension Linear

A

Dimension Along Curve

3. Click the magnifying glass to open the Dimension Styles dialog box.

C Meodify Dimension

AVAVAVAVAYAVAVAVAVAVE AR VA VA Ve

4

[I'"'l “CT_Dim_Traffic

i ]|— Dy

Alignmert: [ True

Location: | Manual

-

AR

a4

’<'3 Angular Dimensicning E =] @ﬁ
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4, In the Dimension Style dialog box, go to the Units tab. Set the Units Accuracy to 0 and set
Angle Format — Units: to Length.

Dimension Styles - CT_Dim_Traffic =1 =S
Style  Miew

-—-_ 1 -r n j - (—ll

o b 1= - )

- DEE]] X288 |

Dimension Styles - Geometry | Units | Tesdt || Symbology | Advanced

Style:{none) Frimary Units Secondary Units

. 7| Use Working Units Show Secondany Units

w1 Label Format: [Mildlabel hel Format: [

% 18172 Master Uritz: |40 foot

& 172 _ et Ui 10 o g

& 1/ P Sub s _inc

< 13 Accuracy: [D T

%= 1/16 Main Prefoc: Main Suffoc:

= 3 Ipper Prefix pper Suffix

= 1 Leading Zero Trailing Zeros

%= 3/8

= 332

s Scale

=" Beference Scale

%= 10 Scale Factor: | 1.000000 D.DDDC S
%= 20 i
%= 25 Metric Format Trailing Zeros
=30 |Use Comma for Decimal

== 40 Units Separator: | 1234.56 hd

%= 50

%= 80

% 100

%= 200

%= 500

%= 1000 =

5. Click on the two points on the curve you wish to dimension. Then click again to select the
length of the dimension lines. Click again to place the number. Then right click to accept
the dimensioning.
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3.5.7 Sign Details

1. First select the needed sign detail from the Sign Details drop down menu and place it at
desired location on sheet.

M] - MicroStation V8i (SELECT=series 3) (1) >
Location Survey  Traffic Motes | Sign Details | CTDOT 2007 Litilties >
@ -/ -3 - [ 3000000800  »| 310117 5
30-0801,9599 ko 310118 Jt
40-0000/2299 LA B ) |
40-2300/4399 ko 310122 >
40-4400/4499 k3140125 >
40-4501/9959 k310135

50-0000/2639
50-2640/5299

31133
31-M65

SEE CATALOG OF SIGNS
BY DIVISION OF
TRAFFIC ENGINEERING

2. Next select the Bubble or Block cell for Sheet Aluminum or Extruded Aluminum
depending on which one you need and place it next to Sign Detail.

>

A 0 B AT A & 00 & & 4

Sign Details an

% O Sheet Aluminum - Small Bubble

\>- W Sheet Aluminum - Small Bubble Back to..
2 E Shest Aluminum - Medium Bubble

\>- R Sheet Aluminum - Medium/Small Bubble

\>- T Shest Aluminum - Medium Bubble Back t..

:i A Sheet Aluminum - Large Bubble

5 Bxtruded Aluminum - Single Location Bla..

\>- [ BExtruded Aluminum - Double Lecation BL.

\>- F  BExtruded Aluminum - Triple Location Block
|G Arc
¥ 7 Line

2
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3. Select the Arc tool for either sheet or extruded aluminum and place it to connect the
detail and call out. For Method select Start, Mid, End and follow the prompts for
placement.

Sign Details -

J ¥

e

:/ {Sheetﬁulurr.inl..m - Small Bubble

i |l Sheet Aluminum - Small Bubble Back to

) Place Arc || =] @

Method; Start. Mid. End | 3

:/ E Sheet Aluminum - Medium Bubble

:/ R Sheet Aluminum - Medium/Small Bubble

:/ T Sheet Aluminum - Meaiulzubble Back t Badius:
: - Length:
= A& Sheet Aluminum - Large Bubble Start Angle:
- |5 Extruded Aluminum - Single Location Blo Sweep Angle:
Direction: [CCw -

:/ D Extrded Aluminum - Double Location Bl

F| Extrded Aluminum - Triple Location Block

>,
|

_J GlArc 3

\d 2\ne 4 ) Place SmartLine || (=] @
ABG X Fill In Single Enter-Data Field 5 . Segment Type: ||JI'|ES—"'| 4

Vertex Type: | Sham - | '

AC'-:—r.G oo mea o [1 BTR

B ' o o

as V| Edit Text /| Join Blements
:l:{ B Add To Graphic Group ?. ﬂ

4. Then select the Line tool and connect the call out to the sign you are detailing.
5. Select Fill in Single Enter Data Field in the call out bubble/location box.
6. Add Text and Edit Text as needed

7. Add all elements of the sign detail to a Graphic Group

51-6611

51-6616
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3.5.8 Detail Blow ups

When doing blow up details it is better to reference the layout model(s), and move and scale,
rather than to copy the features into the sheet model, this way the blow-up stays current with
design changes.

1. Open the References dialog box. Select the Layout Model(s) and copy the attachments,
Right click and select Copy.

1] References (6 of 6 unique, & displayed)

Tools

£

Settings

| B 5da| ¥

>

=E

I -
20|20

ESR(ECR=5

A _FJ i .
13| 3w

Set ¥ 4 Logical File Mame Model ion  Presentation  Visit =
1 el Highway \__\HW _MST MDL_1234 1234 Layoutdgn 3D Desient Wirsframe  Dyr/=
2 SWW Survey PoMEemee A0 R 408 4990 GRM.dgn 30 Desient  Wireframe  Dyr
3 * Traffic Attach... | Class.dgn 20 Desiert  Wireframe B
Detach
4 b
Feload
Scale | 1.000000 : ptation | 0° 0| 0.000
. Exchange
EEIT :__3.|LL"E 3|f "_E Open in New Session Nested Mtachments: |Mo Nefllow = | Mesting Depth:
MNew Level Display: |Config Vanable!  tctivate -
Deactivate
Move
ETR—
Scale
VA AVAVAVAVE

2. Toggle on as shown below and data point in View 1 and then again to where you would
like to move them and reset to accept.

r‘% Copy Reference Attachment E' =] '@1

Copies i
Move Boundary with Reference
Use References Dialog List

lse Fence: |Inside -
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3. Select the copied reference attachments, right click and select Scale, or click on the Scale

Reference icon. Make sure all needed files are highlighted.

1] References (6 of 6 unique, & displayed)

Tools Settings
T— ale ¥ ¥ L T
= || [T By # i e T
= i‘ —ﬁ(‘ ] :"( & a:zj‘ 'St £
Set ¥ 3 Logical File Mame Scale Referenc
1 Highway OCNHWOMST _MDL 1234 1234 Layout.dgn 3D Design 3N
2 SWW Survey U ASumeey SV 01234 1234 GEM.dan 30 Design 3N
3 Tffic ATR_MST _S5P_1234 1234 Class.dan 20 Design AN
5 Highway-1 O CAHWOMST _MDL 1234 1234 Layout.dgn 3D Design 3N
[ Traffic-1 ATR_MST _S5P 1234 1234 Class.dan 20 Design AN
7 i ATR_MST _S5P_1234 1234 Class.dan 20 Design AN
' 1
Scale | 1.000000 : | 1.000000 Rotation | 07 Offset X -
EEW r_1,|lJJ|E .‘fh| ¢ |Ew =) | v (3] L:_iu s | | Mested Attachments: [No Nesting
New Level Display: |Config Varable * | Georsferenced: Mo -

4. Inthe Scale Reference box input a scale factor and follow the prompts to accept.

) Scale Reference Ell [=] '@
Method:

Scale Factord | 2.00|

Maove Boundary with Reference
Use References Dialog List

Ise Fence: | Inside -

5. In the Sheet Composition Task select Signal Plan Annotation > Circle Detail Blow Up
and place a circle around what you would like to detail. This will serve as the clipping
boundary. In the reference dialog box select the files you need clipped, right click, and
select Clip Boundary. Select the element method and click on the circle.

Set Reference Clip Bounda [ = |
) p ry =]

| ‘Method: | Element - |

isting Clip Masks

SCa

Use References Dialog List
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6. Use the tools Circle Detail Blow Up, Detailing Note, and Detailing Text to label the
detail. Turn Off levels as needed.

General Annotation v
Signal Plan Annotation HEERA

A Q Call Out

A 'l General Notes Title

A E General Notes

@ F HexagonText Frame
@ T Circle Text Frame
A A Detailing Note A
A S Detailing Text
A [ Proposed by others Text
A F Exsting Text
A 5 Approx. RO
A Z Approx. Street Line i
A X Taking Line
A = Street Name
AV Match Mark Text
~ B Match Mark Line
() Circle Detail Blow Up — it
Ap Edit Text
A

Match Text Attributes ~ ST A7
A? . 2" RMC, 4-14/2)
Change Text Attributes I".

i Fill In Single Enter-Data Field
A E
0\9 Edit Tags
Signal Head Diagram
Phasing and Movements

Charts

Ki|€||€|| ¢

Sian Detail

7. Move the reference files in the detail around as needed and adjust the size and
placement of the clipping circle.

8. To dimension the Detail you will need to select the correct dimension style. The base
scale for all tools in Traffic Dimensioning Tasks is 1in = 40 ft, if you scaled the reference
files by 2 you will need to set a Dimension Style that uses 1 in = 20 ft.

9. Select Element > Dimension Styles, select CT_DIM_Traffic_20 (if you scaled the
references by 1.5 use CT_Dim_Traffic_30)

10. Use the Dimensioning tools to dimension the detail.

11. Select Detailing Text to label the scale of the detail.
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Section 4 Additional Workflows and Help

4.1 Screening and Level Display Automation

4.1.1 Set Reference Levels Tools

The Traffic Task includes two tools to help automate turning on and off levels and adjusting their
appearance in your reference files. The tool shown below on the left is to be used when you are
in a design model laying out the features. The tool shown below on the right is to be used when
you are in a cut sheet (sheet model) doing the annotation. This tool also overrides the level
symbology of the reference files to the preferred look for PDF creation.

PLEASE NOTE:
Do not use nesting when referencing, if you would like to be able to utilize these

tools.

Tasks v 1 >§ Tasks v FX),
-9 - > |0-0 -6 )
Tasks v | Tasks v | )_g

l Traffic JTrafﬁc
‘,Sheet Composition

.OJJ. O» @» A» \>»m>

Getting Started

i
«
v

i

]

>
NN AINN NN NN

s g e
J} ﬂ»iﬁ?vgﬁl_:lﬁ(ﬂuvﬁgr >
i, O, @ A, 1 >
Setup and Borders ==E=6>
>
2
)

@) Q Guide Book

é \@et Design Model Reference Levels)

Ground Equipment

:ég&t Sheet Model Reference Levels >

\5- ' Plan Border
\>- E Signal Border

<

%
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4.1.2 Reference File Logical Names

The correct logical name is needed for the Set Reference Levels Tools to work properly. If you

don’t put these names in correctly, you will not get the desired outcome when running the tools.

It should be noted that these tools only turn on and off Traffic, Survey and Highway levels, other
discipline reference files level will need to be turned on and off manually in the Level Display
dialog box.

To do this simply open the references dialog Box and double click on the reference file. In the
Logical Name field type in Logical Names listed in 4.1.2.1 and 4.1.2.2. Each logical name needs to
be unique, it is suggested to use numbers following each name.

SWW stands for Screen With Weights, this will plot the level screened at the weight in your level
overrides.

Attachment Settings: sv_dl_1234 1234 grn.dgn E3 ]b
File Name: |\ \Survey'\SV_D1_1234 1234 GRNdgn }’

Full Path: . survey'sv_d1_1234 1234 gm.dagn }

Model: [3D Design - | }

Logical iams? | SWW Survey 1 1D 3

Description: | 30 Design Seed

4.1.2.1 Set Design Model Reference Levels
Since you do not print from the design model, you do not have to screen any reference files.

e Survey ground files
Logical Name: Survey

e Highway design models
Logical Name: Highway

LT References (3 of 3 unique, 2 displayed) “}.
Tools  Settings ;’
- - > %
== - ng Y‘ 5‘( a| I P
St T 3 ( Logical File Name Madel é\

1 Survey SureeynSV_D1_1234 1234 GRM.dan 30 Design _}J

2 Highway HUOAHW_MST_MDL_1234_1234_Layout.dgn 3D Design \}
3
I

4 [} o
Scale | 1.000000 1.000000 Rotation | 0° C;}
|—|—|— | "— 3| ||—J|—J|—JJ Mested Attachments: %
Mew Lewvel Display: ¥ | Georeferenced: \
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4.1.2.2 Set Sheet Model Reference Levels

4.1.2.2.1 Major projects in involving Highway Design

e Survey ground files published using screening
Logical Name: SWW Survey

e Highway design models
Logical Name: Highway

e Traffic design models
Logical Name: Traffic

Your Sheet Models should follow the example below for logical name and Update Sequence

order.
3 oo
Q' G |§|ﬁ£‘£‘g | Hilite Mode: [Boundaries |
iSIot ¥ 3 FileName { Logical \
A \Highways\MSt_ \HW_MST_MDL_1234_1234_Layout Highway
\TR_MST_SSP_1234_1234_Class.dgn Traffic
3 A \Survey\SV_D1_1234_1234_GRN.dgn SWW Survey
A \Highways\MSt \HW_MST_MDL_1234_1234_Layoutdgd Highway-1
5 A\TR_MST_SSP_1234_1234_Class.dgn Traffic-1
Z m J ’
cale | 1.000000 - | 1.000000 Rotation 0"
etX 0000 Y 0000
SN G2 Sl 87 W o2
Nested Attachments: | No Nesting | Display Overdes: |Allow | Nesting Depth: | 1
‘\Leg Level Display. |ConfigVariable v| Georeferenced No v
-~
M Update Sequence =
AN v v
Slot ) File Name Model Logical Name
3 A ASurveiSV_DI_1234_1234_GRN.dgn 3D Design SWW Survey
4 LAHW_MST_MDL_1234_1234_Layoutdgn 30 Design Highway-1
1 IHW_MST_MDL_1234_1234_Layoutdgn 3D Design Highweay
5 ATE_MST_SSP_1234_1234_Class.dgn 20 Design Traffic-1
2 ATR_MST_SSP_1234_1234_Class.dgn 20 Design Trafic
TR_MSH_TCS_1234_1234_007.dgn CT_Civil_ZD_Sheet  Actve Design File
a m L;

Detaut | [ ok | | Cancel
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4.1.2.2.2 Signal only with no major roadway redesign

The Survey file will be referenced in twice. The Existing Edge of Road, Drainage Structures,
Guiderail, Utility Poles and related text will be turned on and not be screened in one reference
file. All the other levels will be screened in the other reference file.

e Survey ground files published using screening
Logical Name: SWW Survey

e Survey ground files with levels on that will not be screened.
Logical Name: Bold

e Traffic design models
Logical Name: Traffic

Your Sheet Models should follow the example below for logical name and Update Sequence
order.

4- | i |._! I | '|ﬂﬂilrhe Made: [Buundarias -:
J3\_%[4:}1 ¥ A File Mame
ATR_MST_SSP_1234_1234_Class.dan

AASurveyiSY D1 1234 1934 GRM.dgn

3
é ATR_MST_SSP_1234_1234_Class.dgn Traffic-1
{6 LASurveyiSV_D1_1234_1234_GRN.dgn Bold
m
cale | 1.000000 1.000000 Rotation | 0
l_:}?"~'.---r X | 0.000 Y | 0.000
B Gl Sl el wT ol
Mested Altachments ~ | Display Ovemdes * | Mesting Depth
%-‘\'*_'_.'. Lewvel Display * | Georeferenced .
M Update Sequence =
A v v
Slot lFlIe- MName Model Logecal Name
3 A ASurvey\SV_DN_1234_1234_GRN.dgn 3D Dasign SWW Survey
6 L\ SurveyiSV_D1_1234_1234_GRNdgn 3D Dasign Bold
5 ATR_MST_SSP_1234_1234_Class.dgn 20 Design Traffic-1
2 ATR_MST_S3SP_1234_1234_Class.dgn 20 Design Traffic
TR_MSH_TCS_1234_1234_007.dgn CT_Civil_2D_Shest Mla_
\
a m L}
Defaull ] [ Cancel ]
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4.2 Underground Utilities and Drainage Pipes

In MicroStation the “Set Reference Levels” tool is used when in a cut sheet (Sheet Model) and it
will leave the Underground and Drainage levels on. Users will turn these levels off in Bluebeam
Revu before getting the plan set signed. Below is the procedure for turning off levels in
Bluebeam Revu.

1. Click on the Layers Icon.

=1 B SR H 6

Open Save Print E-mail Studio Help Resources Contact Unregister About

B~ WL EINE

TR_MSH_TCS_1234_1234_002 (08-21-15) (x

2. Select the levels you would like to be off by clicking on the eye next to each level and
you will be left with a empty box.

D Civil_2D_Sheet> ~ © TR_MSH_TCS_1234_1234_002.dgn<CT_Civil_2D_Sheet>
- © F{efer'en ] « |[®| Refer
r © TR M%T Sgp_uﬂ 1254 Class.dgn=2D Design> v O TR_MST_SSP_1234_1234_Class.dgn<2D Design=
© TR_MST_S¢ Class.dgn<2D Design= » © TR_MST_SSP_1234 1234 Class.dgn<2D Design>
MDL 1234_1234_Layout dgn<3D Design> + © HW_MST_MDL_1234_1234_Layout.dgn<3D Design>
> © Levels
X . 15in. reinforced concrete pipes & ends

> acquistion lines/non access highway lines © acquistion lines/non a
?| all end anchors
> catch basins catch basins
> centerline stationing © centerline stationing

3. When you are done turning off all the needed levels, click the arrow to the right of

and select Save Configuration. H

y HBE

HE W%
rrv'|

v © TR_MSH TCS 1234 1234 002. dqrﬂ -T_Cwml_2D Sheet=
r © F.rnfrnrrnn: BG
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4. Click on the Save Icon before closing the file.
Edit View Document Markup

2 -

Print E-mail

o NE

ae @ = | =
Default . E"‘ -

© TR_MSH_TCS_1234_1234_002.dgn<CT_Cwil_2D_Sheet>
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4.3 User Preference File

1. On the MicroStation Main Menu select Workspace > Preferences.

2. Your Windows login name should appear in the blue title of the Preferences Dialog box
and the Name of Preferences field should match the version of MicroStation you are
running. To check the version you are running close the Preferences Dialog box and
select Help > About MicroStation.

@ Preferences [HallockGa] ) %)
Category Name for preferences | 081109578 )
Database
Input Set View Window Look/Layout Preferences.
Look and Feel Show View ToolBox ’Top hd ]
Mouse Wheel Scroll Bars on View Windows

Operation

OK
Black Back d -> Whit
Position Mapping D ack backgroun e

Raster Manager [ Preserve Aspect Ratio of Views

— LRy —

8 DGN] - Mi tation V8i (SEL
Help Location Survey Tra
Quick Start Guide (PDF)
Contents
Tool Index
Tool Tips
Tracking

Key-in Browser

Bentley Institute Training

Online Support
Bentley Communities
RSS Reader

About MicroStation V8i

About MicroStation V8i X

? MicroStation V8i (SELECTseries 3)
@j Version 08.11.09.714

This product is licensed to:

3. If yourlogin name in the blue portion of the preference both did not match your windows
login go back to 1.2 Creating a User Configuration File. It is imperative that you follow

these directions and you use your Windows Login Name to create your MicroStation User
and Interface.
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4. If the version Number doesn’t match exit MicroStation. Open Windows Explorer and
navigate to the location (Windows 7):

D:\Users\YourUserName\AppData\Local\Bentley\MicroStation\8.11\irRFESEEaUk7nwy13ZRxIQ\prefs

Find your user name with the UPF extension and delete it. Open MicroStation back up
making sure you use your MicroStation Interface and user names and immediately close
MicroStation. The file you just deleted will get automatically recreated. Open
MicroStation one more time and check the Name of the Preference and the version

numbers should now match.

5. If you are having issues getting raster files to align properly. Select Raster Manager
Georeference Tab. The setting should match as shown below:

Preferences [HallockGa] el
Category Name for preferences | 081109578
Database
Input |Set RasteHr Manager preferences.
Look aifd Feel General | Default Attributes | Georeference | Memory OK
Mouse fVhesl . . .
Operatipn Sister File Settings

- . G I
Positi apping Use Sister File, if Present, for Georeferenced Files
Eafster anager I:‘ Save Location Info in Sister File if Required
elerence Defaults

Spelling

Default Unit Settings

Tags
Task Navigation Sister File: 1 Unit = | 0.002083333 /

Tl__:‘m . . [Survey_Feet Vl
View Options - Civil

View Options \ Raster file: 1 Unit = | 0.002083333

[Survey_Feet hd l

Use Unit Definition Geokey if Present (override PCS unit)

et T S Ay
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4.4 Links

This Document

MicroStation Workflows

Tasks w1 x >

Q- bl |
Tasks : il
ﬁrafﬂc I

N oF 20 B3 il
5, 0,8 A 51

Getting Started.\ HEEA
¥))Q Guide Book J
—= W Set Design Model Referenc..

Ground Equipment .

b4

Span and Mount Assem...

s CTDOT 2007 Utilities

Tag Manager v
Drawing Scales >
. Workflows & Docs »
Misc Tools »

AEC Support Form

Common Issues and Resolutions

CTDOT Digital Design Environment Guide
File Naming Conventions s

: DDE j
CAD Drawing Standards
Replacing the User Preference File

Creating a New Design File

REPLACE UPF
Creating a Detailed Estimate Sheet

Creating a Cut Sheet

Creating a Location Plan

Creatinga ' pyplishing MicroStation
CTDOT Inf Sheet files to PDF

CTDOT InRoads V8i Survey Guide

Publishing Micrsostation Content to PDF
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CTDOT - SELECTseries DDE (Digital Design Environment)
http://www.ct.gov/dot/cwp/view.asp?a=3194&q9g=483668&PM=1

This link will give you access to all AEC Applications:

» CTDOT Guides:
e MicroStation for Highway Design
e MicroStation for Traffic engineers (This Guide)
e InRoads Guide for Designers
e InRoads Guide for Surveyors
» Miscellaneous Workflows:
e USGS Permit Plates
e Project Explorer & managing Drawing No.
e Data Acquisition Tools
e StormCAD SS5 for MicroStation
e InRoads for Survey for designers
e InRoads Export to HEC-RAS
e Earth Exploration
» Publishing and Printing
e Publishing MicroStation content to PDF
e Printing PDF Engineering content

AASHTO Trnse®port (integrated construction contract management system)

http://www.ct.gov/dot/cwp/view.asp?a=3194&q=484952
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